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1. PRODUCT INTRODUCTION 

1.1. Product Brief 

SC6D0N4 HDMI provides 4 x HDMI input for HDMI multiviewer and PGM feature in one 
device, it can reception 4 HDMI inputs and 2 HDMI outputs. For 1st HDMI output, it can 
provide commercial interface for local monitor usage; for 2nd HDMI/PGM output, it can 
provide PGM feature and transfer it to broadcasting equipments. It also provides 4 x 3.5mm 
analog audio input for audio embedded and a 3.5mm analog audio output for audio 
deembedded.  
 

 

 
 

Front panel 
 
In front panel, SC6D0 provides PGM / feature button for user to control it locally. USB3.0 
interface provides user to record input in various format. It also provides record / snapshot / 
stream / connectivity button in front panel. 
 

 

 
 

Back panel 
 
In back panel, SC6D0 provides RJ45 for internet connectivity. It also provides RS232 and 2 
USB2.0 for user to connect with industrial / commercial controlling method.  
 
For audio and video, SC6D0 provides 4×HDMI、4×3.5mm audio jack for input and 

HDMI(PGM)、HDMI(Multiview)、3.5mm for output. 
 
User can void local UI interface by USB mouse right click, and control SC6D0 by USB 
keyboard/mouse. The UI interface will appear at HDMI(Multiview). 
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1.2. Specification 

Model SC6D0N4 HDMI 
Max. FPS 1920×1080p@300fps(4 HDMI + 1 PGM Channels) 
Recording 

Mode 
Hardware Compression 

Product 
Photo 

 

 
Input 

Interfaces 
� Video 

� 4×HDMI 
� Audio 

� 4×3.5mm 
Output 

Interface 
� Video 

� 1×HDMI ( Multiview / PGM ) 
� 1×HDMI ( PGM ) 

� Audio 
� 1×3.5mm 

Video 
Feature 

� H.264 baseline/main/high profile 
� Support input / output resolutions 

� 1920×1080 
( P60/P50/P30/P25/P24/i60/i50 ) 
� 1280×720 ( P60/P50), 1280×1024 ( P60 ), 
1280×960 ( P60 ) 
� 1024×768 ( P60 ), 800×600 ( P60 ), 
720×480 ( P60/i60 ) 
� 640×480 ( P60 ), 720×576 ( P50/i50 ) 

Audio 
Feature 

� AAC-LC 
� Configurable bit rate range from 32Kbps to 

384Kbps 
� Sample rate : 48KHz, 16bit 

Network 
Feature 

� 1×RJ45 for 10/100/1000Mbps Ethernet 
� DHCP client 

Support 
Streaming 
protocol 

� RTSP over UDP/TCP/Multicast/HTTP 
� RTMP ( Publish ) 
� TS over IP 
� HLS 

Misc. 
Features 

� Web UI for system configuration 
� Firmware upgradable 
� LED indicator 
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� Status with Power Recycle 
� Main function switch 

� Record 
� Snapshot 
� Stream 

� PGM mode switch 
� Full screen 
� Quadview 
� Picture by picture 
� Picture in picture 
� PGM Loop 

� Full screen switch 
� Channel 1 
� Channel 2 
� Channel 3 
� Channel 4 

� 2×USB2.0 (For Keyboard and mouse usage) 
� 1×USB3.0 (For external storage usage) 
� 1×RS232 + 1×RS485 

Record 
Format 

MP4 / TS / MOV 
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1.3. Suggest Temperature/Humidity 

Working 
Temperature 

0~70℃   

Storage 
Temperature 

-20~70℃   

Working Humidity 0%~90%  
Non- Condensing 

Storage Humidity 0%~90%  
Non- Condensing 
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2. HARDWARE INSTALLATION  

2.1. Package Contents 

Item Amount 
SC6D0N4 HDMI 1 
Adapter 1 

2.2. Device Size 

Figure below is the device size of SC6D0N4 HDMI. 
 

 
 

Device Size Diagram 
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2.3. Front Panel Button Function 

 
Main function switch 

Icon Feature 

 

Record 

 

Snapshot 

 

Stream 

PGM mode switch 
Icon Feature 

 

Full screen 

 

Quadview 

 

Picture by picture 

 

Picture in picture 

 

PGM Loop 

Full screen switch 
Icon Feature 

 

Main channel 
selection on Full 
screen, PBP and PIP 
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3. IP Finder 

For using SC6D0 Web UI, please open IP finder and search for the ip address to open control 
interface. The correct ip address can be distinguish by MAC address. 
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4. WEB UI 

Web UI is the internet interface for user to control SC6D0 more convenient, users can control 
them via normal PC or portable devices (EX: Android, iPhone, iPad…etc.) 

 
Username: admin 
Password: 0000 
 

4.1. Language / Firmware 

 
On the top, here are web UI language selection and Firmware version / MCU version. User can 
change Web UI language here. 
 

4.2. Source 

 
This page contains input signal status, input Video Source and Audio Source selection. Users 
can change input video property, source and check input video information here. User can 
select on the top 1/2/3/4 icons to change the channel that willing to adjust. 
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4.2.1. Video Source (HDMI) 

 
Here displayed usable video input interfaces and adjustable HDMI video quality. 
 
Mirror adjust can support on HDMI input interfaces. 

 
 

4.2.2. Video Source (NDI) 

 
When enter NDI feature, SC6D0 will automatically scan the same domain, NDI stream will 
automatically appears here. 
 

4.2.3. Video Source (IP Stream) 
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For SC6D0 up streaming, please enter the Streaming page and follow the following 
information (The IP address will vary by environment, please check IP finder to make sure 
the IP address.). 
 

 
Here are different stream receiving setting. All supported formats are listed as below. 
 
1.RTSP 
rtsp://[account]:[passwd]@[ip]:[port]/[session name].mpg 
Example: rtsp://root:root@10.10.41.228:556/session0.mpg 
 
2.RTMP 
rtmp://[ip]/[session name]  
Example: rtmp://10.10.41.189/live 
 
3.HLS 
http://[ip]/hls/[CH]/[Session name].m3u8  
Example: http://10.10.41.228/hls/3/session0.m3u8 
 
4.TS Unicast 
udp://[localhost]:[port]  
Example: udp://10.10.41.189:556 
 
5.TS Multicast 
udp://234.0.0.1:[port]  
Example: udp://234.0.0.1:556 
 
6.NDI 
NDI Name  
 
7.SRT Listener 
srt://[ip]:[port]  
Example: srt://10.10.41.228:1202 
 
Delay Duration: Select delay latency for reception. 
-1ms: Ultra low latency (RTSP only) 
0ms: Low latency 



 

This information contained herein is the exclusive property of YUAN and shall not be distributed, reproduced, or disclosed in whole or in part without prior 
written permission of YUAN.  

14 

14/48 

1~1000ms: Latency 
 
Reconnection Timeout ( ms ): Select time duration for timeout reconnection. 
Please set the value more than 500ms 
 
※For Streaming example, please check chapter 4.5 for further information. 

 

4.2.4. Internal File (Video, Picture) 

 

 
SC6D0 can also play files inside flash disk, please attach the flash disk and select the file to 
play it. 
Support format: H264 
File type: mp4, mov, ts 
Audio format: AAC  
Support image file type: jpg, png. 
 

4.2.5. Audio Source 

 
In audio source block, user can select audio input source from Embedded HDMI audio or 
3.5mm audio source (Embedded audio is the same as selected video interface). 
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4.2.6. Input Signal Status 

 
In input information block, user can check signal status and signal format. 
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4.3. Encoder 

 
Encoder page contains Main Encoder and Sub Encoder 2 parts, which allows user to change 
video and audio encode, this page also provides user to change sub streaming encoder. 
 

4.3.1. Main Encoder/Sub Encoder 
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Resolution: For encoders here, we provide Same as input, 1920*1080, 1280*720 and some 
other popular resolutions. 

 
 
Frame Rate: SC6D0 have Same as input, 60, 50, 30, 25, 20, 15, 12.5, 10, 5, and 1 
framerates for user to select 

 
 
Profile: User can adjuse here for H.264 profile selection, it supports high, main and 
baseline. 
 
Level: H264 level support, SC6D0 provides 41, 40, 32, 31, 30, 22, 21, 20, 13, 12, 11, 10, 
and 1b. 

 
 
Entropy: Entropy encoding selection, SC6D0 can support both CAVLC and CABAC.  
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GOP: H264 group of pictures setting (from 255~1). 

 
 
Video Bitrate (bps): Video bitrate select (44K~64M) 

 
 
Customize Video Bitrate：User select bitrate. 

 
Crop-X/Y/Width/Height: Crop the needed video and display. 

 
 
Audio Frequency: Audio frequency select 
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Audio Bitrate (bps): Audio bitrate select 

 
 
ColorRange: Select between Full Color or Limited Color. 

 
 
 

 
  



 

This information contained herein is the exclusive property of YUAN and shall not be distributed, reproduced, or disclosed in whole or in part without prior 
written permission of YUAN.  

20 

20/48 

4.4. Record 

 
Record page allows user to change the video format that recorded to USB3.0 disk drive. 
On the top 1/2/PGM is the channel that desired to record; and the 2 block in the middle is the 
main/sub record format. 
 

 
SC6D0 also provide upload feature, on the right hand side, user can check 3 icons for upload 
usage. 
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4.4.1. Main Record/Sub Record 

 
Here are the parameters that allow user to adjust their record format. 
Encoder source: Select the encoder that willing to record, here are Main Encoder, Sub 
Encoder and disable selections. 
File name: The file name setting, this would be the file name recorded.  
Type: Decide needed file type, we offer MP4, TS, and MOV at present time 
Duration: Setting recording time. Recording will automatically stopped when the time is 
up. 
Content: Record content includes audio+video, video only or audio only. 
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4.4.2. Upload-NFS 

NFS is a distributed file system protocol, for user to access files via network. 

 
 
Storage Mode: User can select save mode here. 
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4.4.3. Upload-FTP 

SC6D0 can save files to FTP, please setup FTP site, password and accounts then select your 
save method. 

 
 
FTP mode: PASV or EPSV 

 
 
Storage Mode: User can select save mode here. 

 
4.4.4. Upload-Other Settings 

On other setting block, user can check upload status and select server, check local USB disk 
content and filter for the file browser.  

 
 
Filter Type: Filter record files or picture only. 
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4.5. Streaming 

 
This page contains SC6D0 streaming settings; user can decide which encoder’s stream will 
send out and select streaming type here. 
On the top 1/2/3/4/PGM is the channel that desired steaming; and the 2 block in the middle is 
the main/sub streaming format. 
 

4.5.1. RTSP Streaming 

 
Encoder Source: User can select between main encoder and sub encoder. 
Streaming Type: Here are RTSP, RTMP, TS, HLS, NDI, SRT and Youtube streaming type 
SC6D0 available. 
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RTSP port: RTSP server port 
RTSP HTTP Port: RTSP HTTP server port 
Account: RTSP account, setting this for other users to link with RTSP mode. 
Password: RTSP password, setting this for other users to link with RTSP mode. 
Session Name: RTSP Session name. 
Multicast: Enable or disable multicast. 
Enable: Enable multicast, using broadcast to transfer package. When multiple clients are 
receving package, this setting can reduce CPU usage. 
Disable: Disable multicast, using unicast to transfer package. When multiple clients are 
receving package, this setting will increase CPU usage. 
 
Content: Select the willing streaming data content. 
Play URL: Streaming address for other devices to receving. 
 
RTSP format listed as below. 
rtsp://(Account):(Password)@(Source IP address):(port)/(Session name) 

 
After the setting as above, the streaming address will be 
rtsp://root:root@10.10.41.242:554/session0.mpg 
(IP may different by environment) 
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For down streaming side, please enter source->video source->IP Stream 

 
After enter the Web UI, please setting as below (The IP address will vary by environment, 
please check IP finder to make sure the IP address.). 
Source URL : rtsp://root:root@10.10.41.242:554/session0.mpg 
Account : root 
Password : root 
User can key in Account and Password info into Source URL or key in Account and 
Password information on the below block. 
 
Decode video format: H264 
Decode audio format: AAC 
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4.5.2. NDI Streaming (30 min ) 

 
NDI Group: Device name 
NDI Name: NDI streaming name 
After press Start Stream, the NDI stream can be received by NDI Tools 

 
SC6D0 had build-in trial version of NDI streaming, which can provide user to transfer NDI 
streaming for 30 minutes.  
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4.5.3. SRT Streaming 

Here are 2 modes available on SRT streaming, Caller and Listener.  
 
SRT Listener mode turn SC6D0 into a sender, send SRT stream directly to other receivers. 
SRT Format: srt://10.10.41.201:[port] 

 
Stream Type: User can select caller or listener (Listener here) 
SRT Port: Setting port for streaming out. 
Passphrase : Setting the password for this stream. 
 
Press to get a URL for receives; enter the URL at access point to receive the streaming  
Example: srt://10.10.41.201:1200 
 
SRT Caller mode turn target device as a portal, SC6D0 send SRT stream to target then the 
target will send device to other receivers. 
SRT Format: srt://[ip]:[port] 

 
Stream Type: User can select caller or listener (Caller here) 
SRT Port: Setting port for streaming out. 
Caller IP Address: Setting streaming out IP address. 
Latency: Video latency time (20~8000ms) 
Passphrase: Setting the password for this stream. 
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We’ve take Wowza as an example for demonstration on SRT Caller 
 
1. Select Live 

 
 
2.  Add Stream File 

 
 
3. Set Stream File and Stream URL 

 
※Stream URL is the current platform IP address. 

 
4. Select Stream and Connect 
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5. Update MediaCaster Type to SRT 

 
 
6. Select Incoming Streams and select the stream 

 
 
7. Set Caller IP Address and SRT Port to SC6D0 
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8. Press Start Stream and SC6D0 will start to stream the video to Wowza Server. 
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4.5.4. TS Streaming 

Here are two formats TS streaming support, unicast and multicast. 
 
For unicast, user need to provide “Client Side” IP address for TS URL, and setting a port 
for it. 
TS unicast Format: udp://[localhost][port] 
Example: Streaming TS to device 10.10.41.288, user need to add TS URL as below. (user 
can change port to willing value) 

 
 
For multi cast, user needs to fill ipaddress for TS URL and giving it a port value.(The IP 
address range can be 224.XX.XX.XX~239.XX.XX.XX), Here is a example with 234.0.0.1. 
TS multicast Format: udp://234.0.0.1:[port] 
Example: User can set TS URL to udp://234.0.0.1:8888 for multicast. 

 
 

4.5.5. RTMP Streaming 
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RTMP URL: For RTMP server address usage. 

4.5.6. YouTube Streaming 

 
 
After select Streaming Type to YouTube and press start streaming, SC6D0 will 
automatically generate USER CODE for user to connect with YouTube account. 
(Remember to allow the browser popup window for connecting YouTube) 

 
 
After press NEXT, the connectable user account will appear for user to select. 
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When the connection is succeed, please start streaming. 

 
 
YouTube live video streaming will automatically generates after the setting is completed. 
YouTube streaming website https://www.youtube.com/live_dashboard 

 



 

This information contained herein is the exclusive property of YUAN and shall not be distributed, reproduced, or disclosed in whole or in part without prior 
written permission of YUAN.  

35 

35/48 

4.6. Snapshot 

 
4.6.1. Snapshot 

 
Capture: Select Enable or Disable capture feature. 
File Name: User may decide willing capture file name. 
Type: Select snapshot file format, SC6D0 provides BMP and JPEG for user to select 
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4.7. CG 

 
User can change OSD contents here, including Text label, place (Location-X, Location-Y) and 
color (Background Color, Foreground Color). 

 

4.7.1. OSD Setting 

 
OSD Layer: Select willing modify OSD layer (SC6D0 has 4 OSD layers) 
OSD Type: Type of OSD, user can select between picture and text. 
Text: Text label for channel 1~4 and PGM 
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Location-X: OSD offset of X axis. 
Location-Y: OSD offset of Y axis. 
Text Size: OSD text size. 
Text Color: OSD text color. 
 
Transparent: Adjust transparent value (0~255)  
Effect: OSD display method 

 
 
Effect Distance: OSD effect distance (Unit: Pixels) 
 
Back Ground Type: Enable text background to Font Border, Fill or disable. 

 
 
Back Ground Color: Decide text background color. 

 
 

4.7.2. OSD Example 

Example: Effect->Cut in; Back Ground Type->Font Border; Back Ground Color->Black. 

 
 
Example: Effect->Cut in; Back Ground Type->Fill; Back Ground Color->Black. 

 
 
Example: Effect->Scroll left to right; Back Ground Type->Fill; Back Ground 
Color->Black. 
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4.8. PGM 

 
This page contains PGM port video output layout selections. 
 

Full Screen 
Mode 

 
Full screen mode will display whole input video into one 
PGM output. 
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Picture in 
Picture 
Mode 

 
For picture in picture mode, first channel select is the main 
channel, the second channel selection is the minor channel. 
This mode also provide PGM Advance mode for user to 
adjust their video layout. 

 
The PGM Advance layout is listed as below. 

 
Picture by 

Picture 
Mode 

 
Picture by picture mode will display all 4 channels in one 
screen, but there will be a main channel in the right. There 
also a main channel selection in the bottom. 
This mode also provide PGM Advance mode for user to 
adjust their video layout. 
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The PGM Advance layout is listed as below. 

 
Quadview 

Mode 

 
This mode will display all 4 channels in one screen. 

PGM Loop 
Mode 

 
PGM Loop mode will automatically loop all channels. 
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PGM: PGM video scale setting. 
PGM Background Color: Change when no video input, displayed PGM background color. 
PGM Loop Period (sec): The time can setting to 1~60sec. 
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4.9. Mixer 

 
Select PGM audio to Mixer or follow PGM 
Mixer: Mix all input audio and outputs. 

 
Follow PGM: Mix audio input source that channels displayed by PGM mode. 
Channel 1/2/3/4 Sound: Set output audio as channel 1/2/3/4. 
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4.10. Monitor 

 
HDMI : PGM Channel, user can select PGM mode or Multiview mode for it. 
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4.11. Network 

 
DHCP: Enable/disable DHCP feature. When disable DHCP, please provide necessary 
internet parameters for SC6D0. 
Static IP: Setting SC6D0 static IP 
Subnet Mask: Setting SC6D0 subnet mask 
Default Gateway: Setting SC6D0 default gateway 
Primary DNS: Setting SC6D0 primary DNS 
Secondary DNS: Setting SC6D0 secondary DNS 
 
Network Status: Here presents IP address and network status 
Time Setting: Set time server and sync type. 
Account and Password: User can assign new account and password here. 
Timeout Periods: Set user using time after log in, when the time is up, the user will be 
logout. 
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4.12. System 

 
In system page, user can set account /password, system reboot, format attached USB disk, 
check network status/setting and Firmware Update here. 
 

4.12.1. Device name setting 

 
User can set device and channel name here. 

 

4.12.2. Disk Format 

 
User can format attached USB disk drive here, supported formats are listed as below. 

 
 

4.12.3. Device Config Setting 
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User can save the setting or load previous settings here. 
 

4.12.4. Firmware Update 

 
Please press Browse button to select firmware and Update button to update it, during 
update firmware, please don’t turn off power and wait until upgrade progress 
complete. 
 

4.12.5. System Control 

 
Restore to default will erase all settings and back to original, and Reboot button will restart 
the SC6D0. 
 

4.12.6. Debug Mode 
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4.13. Status 

 
User can check SC6D0N4 status here (Including input signal, streaming status, etc.) 
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5. VERSION 

5.1. Version 1.0 

� Initial version. 

5.2. Version 1.1 

� Add network setting. 
� Fix typo. 
� Update PGM available modes. 
� Fix OSD block diagram. 

5.3. Version 1.2 

� Update network setting. 

5.4. Version 1.3 

� Update Web UI. 
� FW:1.95 - 1.2.3 
� MCU:17.9.11.0 

� Add login part. 

5.5. Version 1.4 

� Update Web UI. 
� SW:1011.2.7 Beta 
� FW:17.12.19.0 

5.6. Version 1.5 

� Update spec to V3.31 

5.7. Version 1.6 

� Update spec to V1.3.1 

5.8. Version 1.7 

� Update spec to V1.3.6 

5.9. Version 1.8 

� Update spec to V1.4.1 

5.10. Version 1.9 

� Update SDI information 

5.11. Version 2.0 

� Update YouTube streaming 

5.12. Version 2.1 

� Update FTP chapter  

5.13. Version 2.2 

� Update 4.2.3 Video Source chapter 
� Update 4.5 Streaming chapter 

5.14. Version 2.3 

� Add Front panel button info 

5.15. Version 2.4 

� Update spec to V2.4.0 
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